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Appendix A                Biometric Watchlist Procedures and Maintenance 

verview
 
O  

. The Biometric Watchlist 
  

nance 
tion and Removal  Procedures  

onto an Iris Scanner 

. The Biometric Watchlist.

 
1
2. Duties & Responsibilities
3. Biometric Watchlist Mainte
4. Biometric Watch list Alert Nomina
5. Creating and Searching a Biometric Watchlist 
6. Assign a BAT Record to a Watch List  
7. Load a Biometric Watchlist from a Bat 
8. Load a Biometric Watchlist onto a HIIDE device 
 
1  

A. Background
 

.   

(1) The Biometrics Watchlist contains a list of individuals who have had 
biomet which 

 

)  The NGIC Biometric Watchlist is a biometrically-based repository of 
informa  the 

 to 

(3) Watchlist Contents

 

rics collected on them, and are considered to have derogatory information 
warrants further action upon their encounter.  This list triggers an immediate alert should
these individuals be encountered during BAT screening, enrollment, or badging 
operations.   

  
(2
tion to identify persons assessed as a threat to Coalition Forces (CF), and to

national security of the United States.  The purpose of the Watch list is to provide a 
course of action in the event an individual on the Watchlist is encountered, as well as
provide timely notification of the event to the appropriate organizations.   
 

.  The Watch List contains several High Value Targets 
(HVIs)

o 
e 

      a.  The NGIC Watch list is divided into separate tiers; each providing a 
 

 
1. Tier 1:  Detain if Encountered 

er development by NGIC) 
y or Police 

Training 

 or Persons of Interest (POIs) who pose a potential, direct, or imminent threat 
against Coalition Forces and U.S. Interests in the Iraqi Theater of Operations (ITO), t
the Government of Iraqi, and its security forces.  This includes:  NGIC watch list, and th
MNF-W watch list. 
 

different course of action to be taken by the unit conducting the screening or
enrollment.  These tiers are: 

2. Tier 2:  Detain for Intelligence 
3. Tier 3:  Deny Entry to U.S. (und
4. Tier 4:  Do Not Hire/Deny Base Access/Disqualify for Arm
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5. Tier 5:  Latent to Latent (Under Development) 
Tier 6:  Tr6. ack Movement 

 
                  include the following HVI target lists of 
individuals that biometrics data is maintained upon within the ITO: 

. MNF-W HVI list 

list 

 HVIs) 
 

2.  Duties 

b. The MNF-W Watch list will

 
1. CENTCOM HVI list 
2
3. AO Denver HVIs list 
4. AO Raleigh HVIs 
5. AO Topeka HVIs list 
6. SOTF-W HVI list 
7. MND-B HVI list 
8. MND-N HVI list  
9. MEU HVI list (AO

& Responsibilities 
 

atchlist Manager at the MNF-W G-2, BCT/RCT S-2 , 
attalion S-2, and Company levels in order to maintain an accurate Watchlist of registry 

that

A. Each unit will assign a W
B

 lists each Watchlist that he and his subordinate managers maintain. 
 
B. MNF-W G-2 Watchlist Manager. 
 

(1)  Develop and maintain an MNF-W Watchlist that encompasses the MNF-W 
HVI list, all cross-boundary HVI lists (i.e. SOTF-W), rotating MEU AO HVI lists, and 
all BCT

 and the BCT/RCT to create a ‘ghost 
record’

 G-2 Watch list Manager will publish 
this list

/RCT, Battalion and Company HVI lists. 
(2)  Validate that HVI’s included in the Watchlist have a biometric profile in the 

NGIC biometric database.  Coordinate with NGIC
 of an HVI if biometric data is missing or incomplete. 
(3)  Coordinate MNF-W Watchlist nominations with the NGIC BIFT on a daily-

weekly basis indicating changes, or “No Change.” 
(4)  When submitting, include the following: the Unit, HVI Watchlist Name, the 

Watchlist Manager POC information.  The MNF-W
 on the MNF-W Biometrics Portal at:  

http://www.mnfw.usmc.smil.mil/C12/C5/MNFW%20BAT%20Portal/default.aspx  
(5)  Ensure that the current NGIC & M
(6)  Publish the Watchlist POC information on the MNF-W BAT Portal and 

NF-W Watchlist is downloaded each day. 

val
 

idate current information on a monthly basis, or as units conduct RIP/TOA. 

C. BCT/RCT S-2 Watchlist Manager.   
 
At the BCT/RCT level, the Manager will: 
 

(1)  Develop and maintain an HVI list that encompasses all Battalion and 
Company HVI lists. 
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(2)  Validate that HVI’s have a biometric profile.  Identify HVI’s that do n
biometric data. 

ot have 

Manager on a daily-weekly basis indicating changes, or “No Change” at:                                
mnf-wg

(3)  Submit HVI BAT Watchlist recommendations to the MNF-W G-2 Watchlist 

2ops@mnf-wiraq.usmc.smil.mil
(4)  When submitting, include the following: the Unit, HVI Watchlist Name, the 

Watchlist Manager POC information.  The MNF-W G-2 Watch list Manager will publish 
this list on the MNF-W Biometrics Portal at:  
http://www.mnfw.usmc.smil.mil/C12/C5/MNFW%20BAT%20Portal/default.aspx  

(5)  Ensure that the NGIC & MNF-W W
 

atchlist is downloaded each day. 

D. Battalion S-2 Watchlist Manager. 
 

(1)  Develop and maintain an HVI list that encompasses all Battalion and 
Company HVI lists. 

ot have 

Manager on a daily-weekly basis indicating changes, or “No Change”. 

ager will publish 
this list

(2)  Validate that HVI’s have a biometric profile.  Identify HVI’s that do n
biometric data. 

(3)  Submit HVI BAT Watchlist recommendations to the BCT/RCT S-2 Watchlist 

(4)  When submitting, include the following: the Unit, HVI Watchlist Name, the 
Watchlist Manager POC information.  The MNF-W G-2 Watch list Man

 on the MNF-W Biometrics Portal at:  
http://www.mnfw.usmc.smil.mil/C12/C5/MNFW%20BAT%20Portal/default.aspx  

(5)  Ensure that the NGIC & MNF-W W
 

atchlist is downloaded each day. 

E. Company S-2/Intel Marine.   
 

(1)  Develop and maintain an HVI list that encompasses all Company HVI’s. 
(2)  Validate that HVI’s have a biometric profile.  Identify HVI’s that do not have 

bio

Manager on a weekly basis indicating changes, or “No Change.” 

st Manager will publish 
this list

metric data. 
(3)  Submit HVI BAT Watchlist recommendations to the Battalion S-2 Watchlist 

(4)  When submitting, include the following: the Unit, HVI Watchlist Name, the 
Watchlist Manager POC information.  The MNF-W G-2 Watch li

 on the MNF-W Biometrics Portal at:  
http://www.mnfw.usmc.smil.mil/C12/C5/MNFW%20BAT%20Portal/default.aspx  

(5)  Ensure that the NGIC & MNF-W W
 

atchlist is downloaded each day. 

3. Biometric Watchlist Maintenance 
 

A.  Overview.  The management of the biometric Watchlist is one of the most critical 
spects to a successful biometric program.  Management of the Watchlist includes the 

con
a

tinual addition, deletion, update, or dissemination of records to produce the most 
current WATCHLISTs.   
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(1) Watch list management will be conducted on a 24 hour cycle in a cascading 
manner

tions to ensure all units across 
the bat a

B.  Watchlist Registries

 from the MNF-W down to the Company level.   
(2) It requires standardization in naming conven

tlesp ce can access the various lists as needed. 

.  Each Unit Watchlist Manager will maintain a Watchlist 
reg

(1)  The Watchlist Registry will be updated weekly and submitted by the 
BCT/R day 

(2)  The Watch list Registry will include the Unit, Watchlist Name, and Watchlist 
POC.  T

C.  Watchlist Updates.  BCT/RCT S-2 Watchlist Managers will distribute emails 
form ate 

istry. This registry will detail each Watchlist that consists of your HVI targets that 
have collected biometrics in the database.   

CT Watchlist Managers to the MNF-W G-2 Watchlist Manager each Satur
(NLT 2000 hours).  

he MNF-W Watch list Manager will publish this list on the MNF-W BAT Portal, 
or by email. 

atted like the one below to their respective subordinate units.  The Watchlist Upd
Message will have a standard formatting and elements of information are common across 
the MNF-W to ensure essential elements of information are passed to the lowest level.   

 

 

MNF-W G-2 Watchlist Manager 
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 BCT/RCT S-2  Watchlist Manager 

 

 

4. Biometric Watchlist Alert Nomination and Removal  Procedures (NRP) 
 

A. The following are guidelines for outlining the procedures for adding and 
removing individuals from the Watch list; and alert status of individuals placed on the 
NGIC or MNF-W Biometrics Watchlist. 

 
B. The NRP is a weekly process in which the RCT/BCT S-2’s review the Tier level 

and Alert status of their HVIs on the WATCHLISTs within their respective AOs. 
 

C. There are two categories:  
 

(1)  Before/After Operations.  The RCT/BCT S-2 Manager will review HVI lists 
for adding, modifying, or removing the status of HVI individuals that are in the 
biometrics database and/or individuals that are on the Watchlist. 
 

a.  Bn S2 – Review, update, and/or consolidates HVI list(s), assess & endorse 
all nominations from the Company level; and forward to RCT/BCT via the Battalion S-2 
Watchlist Manager. 

b.  RCT/BCT – Review HVIs on Watch List and recommend assigning a Tier 
rating. 

c.  MNF-W – Concur/Non-Concur with comments for the Watchlist and 
forward to NGIC. 

d.  NGIC – Approves/Disapproves the Watchlist nominations; updates 
database with ‘Tier’ tag. 

 
(2)  During Operations.  Those individuals that have been screened, enrolled, or 

PID during operations will require: 
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a.  BAT Operator/Company level – Add/update Alert tag during HIIDE-PID 

(as required). 
b.  Report actions to Bn S2 (individual(s) name, and BAT number. 

 
D.  Prerequisites for Inclusion.  Prior to nominating an individual to the NGIC or 

MNF-W Biometric Watchlist, the nominating unit will determine whether the individual 
meets the prerequisites for inclusion to the Watchlist and make a recommendation to the 
appropriate tier to higher headquarters.   
 

(1)  NGIC Tier 1 Nominations: 
 

(a)  The individual must have a collected biometric:  fingerprints and/or iris 
scans. 
 

(b)  The individual must be assessed as a high threat per the NGIC Threat 
Matrix, and/or the individual's encounter in the Iraq Theater of Operations (ITO) suggests 
that the individual is conducting activities which are threatening to Coalition Forces. 
 

(c)  The individual is not in detention; although, there are several exceptions 
to this rule.  These exceptions are: 
 

(1) All foreign fighters are placed on the Watchlist regardless of 
detention status, and are assessed to have resumed high threat activities if encountered 
outside of their host country or under hostile circumstances. 

 
(2) The individual was sentenced to death or a sentence of 15 years or 

more by the Central Criminal Court of Iraq (CCC-I).  If encountered, these individuals 
are presumed to have escaped or were wrongfully released from Iraqi custody. 

 
(3) The NGIC Watchlist Team and MNF-W G-2 Manager will 

coordinate with the appropriate authorities to determine the detention status of all CCC-I 
convicts.  

 
(d)  The individual will not be placed on Tier 1 of the Watchlist for the same 

purposes of which he was adjudicated through legal processes. Exceptions to this rule 
include: 
 

(1) New reporting and evidence generated which reveals that the subject 
has resumed high-threat activities. 

 
(2) New intelligence and/or evidence are revealed which was not available 

during the time of an individual's detention, but makes the individual a high threat. 
 
(3) In the case where a detainee was released through a legitimate and 

recognized means, and it is assessed that he still represents a high threat to U.S. and CF, 
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the individual's re-accession to the Watchlist will have to be closely coordinated with 
theater, including both the appropriate C2 element and the detainee management 
organization.  
 

(2)  NGIC Tier 2 Nominations: 
 

(a)  The individual must have a collected biometric profile:  Fingerprints 
and/or iris scans.  

 
(b)  The individual must possess actionable intelligence that can lead to the 

target/capture of high-value individuals (HVI's). 
 
(c)  The individual is matched to a latent fingerprint which does not 

specifically implicate him/her in insurgent / terrorist activities, but needs to be 
investigated further to ascertain his/her involvement. 
 

(d)  The individual is not in detention. 
 

(3)  NGIC Tier 3 Nominations (Under Development): 
 

(a)  Subject is nominated to Terrorist Identities Datamart Environment 
(TIDE).  This tier of the Watchlist is still under development. 
 

(b)  The Watchlist Team coordinates with Department of State (DoS) and 
Department of Homeland Security (DHS) to ensure validity of nominations.  This process 
is still under development. 
 

(c)  The subject's detention status is irrelevant. 
 

(4)  NGIC Tier 4 Nominations: 
 

(a)  Subject is assessed to pose a threat to Coalition Forces per NGIC threat 
matrix.  
 

(b)  If the subject is a base access cardholder, the nominator must coordinate 
with the specific base access approval authority prior to nominating to Tier 4.  The 
nomination must be consistent with the actions taken by that authority. 
    

(c)  The subject's detention status is irrelevant. 
 

E.  Actions Taken after Nomination.  After a nomination is received from the 
RCT/BCT S-2 Manager, the MNF-W G-2 will forward the nomination to the NGIC 
Biometrics Watchlist Team that responsible for reviewing the nomination, and receiving 
all pertinent information from the source of the nomination.  Once the nomination is 
approved, the NGIC Biometric Watchlist Team will do the following: 
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(1)  The NGIC Watchlist Team updates both Watchlist trackers.  One is sent to 
the Biometric Fusion Center (BFC), and one is sent to corresponding Combatant 
Commands (COCOMs) and agencies.   
 

(2)  The NGIC Watchlist Team inserts encounter statements in related BAT 
records.  Encounter statements differ for each tier.  An example of a Tier 1 alert text is as 
follows: 
 
 (3)  NGIC will attach all supporting documents to the associated BAT record if 
applicable. 
 

(4)  The NGIC Watchlist Team will notify MNF-W of the additions to the 
Watchlist. 
 

(5)  The NGIC Watchlist Team ensures that Biometrics Identification Analysis 
Reports (BIARs) are written for all individuals placed on the Watchlist.  Production of 
these BIARs will be assigned through the NGIC Biometrics Intelligence Fusion Team 
(BIFT) Operations Section.   
 

F.  Watchlist Removal/Denomination Process. 
 

      (1)  Criteria for Denomination:  The removal/denomination process consists of 
removing individuals from one tier of the Watchlist and determining if the next 
appropriate tier is applicable.  Individuals removed from Tiers 1 and 2 typically meet the 
criteria for placement on Tiers 3 or 4 of the Watchlist.  Whereas, individuals removed 
from Tiers 3 or 4, may either be placed on a higher tier, or are removed from all tiers of 
the Watchlist. 

 
(2)  NGIC Tier 1 Denominations:  The following criteria are required to remove 

an individual from Tier 1 of the Watchlist: 
(a)  The individual is detained.  Exceptions include escapees previously 

serving life/death sentence and/or foreign nationals. 
 

(b)  The person is killed and their death is biometrically verified from the 
database. 
 

(c)  The individual's threat value is downgraded.  The NGIC Watchlist Team 
will first review any MNF-W requests for removal from the Watchlist due to a threat 
downgrade.  The final approval for removal will come from the BIP Chief based on a 
recommendation from the Review Board. 

 
(3)  NGIC Tier 2 Denominations:  The following criteria are required to remove 

an individual from Tier 2 of the Watchlist: 
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(a)  The individual is detained.  Exceptions include escapees previously 
serving life/death sentence and/or foreign nationals. 

 
(b)  The person is killed and their death is biometrically verified from the 

database. 
 

(c)  The individual's intelligence value is downgraded.  The NGIC Watchlist 
Team will first review any requests for removal from the Watchlist due to an intelligence 
value downgrade.   
 

 (4)  NGIC Tier 4 Denominations: 
 

(a)  Removals/Denominations from Tier 4 will either be placed on Tiers 1, 2 
or 3 or removed from all tiers of the Watchlist. 
 

(b)  For removals/denominations which result in the removal of the individual 
from all tiers of the Watchlist, the following must apply: 
 

     (1) The person is killed and their death is biometrically verified from the 
database. 

 
(2)  The NGIC Watchlist Team receives removal request from theater or 

an external organization. 
 

(5)  Actions Taken After Removal/Denomination. 
 

(a)  If detained: 
 

(1)  The NGIC Watchlist Team will send all documentation pertaining to 
this individual to the detaining MNF-W unit. 

 
(b)  If killed: 
 

(1)  The NGIC Watchlist Team will remove the individual from both 
Watchlist Trackers, and removes encounter statements from any corresponding BAT 
records. 

 
(2)  The Watchlist Team attaches all documentation of the individual's 

death to corresponding BAT records. 
 
(3)  A BIFT analyst will update the related BIAR. 

 
(c)  If threat or intelligence value is downgraded: 

 
(1)  The NGIC Watchlist Team will determine if the individual should be 

placed on a different tier or removed completely from the Watchlist. 
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(2)  If removed from Tier 1 or 2 and placed on Tier 3 or 4, the NGIC 

Watchlist Team will update both Watchlist trackers accordingly, and replace the Tier 1 or 
2 encounter statement with the appropriate Tier 3 or 4 encounter statement in BAT. 

 
(d)  If a request for removal from theater or an external agency is received: 

 
(1)  The NGIC Watchlist Team will coordinate with MNF-W G-2. 
 
(2)  If the individual was a Tier 1 or 2 denomination, the NGIC Watchlist 

Team will update both Watchlist trackers accordingly, and remove encounter statements 
from any corresponding BAT records.  If placed on Tier 3 or 4, the Watchlist Team will 
replace the Tier 1 or 2 encounter statement with the appropriate Tier 3 or 4 encounter 
statement in BAT.  
 
5. Creating and Searching for a Biometric Watchlist 
 

A.  Alert Status (Tag).    
 

(1) Background.  The Alert ‘status or tag’ is an additional caveat placed on an 
individual on the Watch List.  The Alert provides BAT or HIIDE operators an immediate 
notification of special information on an individual; that includes:  MNF-W Tier 1 
individual, prison escapee, HVI status, a previous CF detainment, a sheik or religious 
leader, someone of intelligence value for a specific purpose, or incomplete BAT data. 

 
(2) Watch list Managers can tag BAT records that are of interest to them with a 

“LOCAL ALERT” message.  These local alert messages are used to inform others of any 
special dispensation, handling, or instructions in the event this individual is encountered 
by any unit.  
 

(3) Actions Required.  One of the four standardized actions will be taken by the 
Biometrics Screener when an Alert tag is identified.  This is the standard text that will 
precede all alerts warning other users that the individual is of interest.  The four (4) 
actions are: 

a. “Detain on contact.” 

b. “Detain for intelligence purposes.” 

c. “Deny Access to US Base or FOB/Do Not Hire/Disqualify From Army 
or IP Training.” 

d. “Do not Detain or Question.” 

                 Alert Examples. Here are a few examples of alerts the operator will encounter 

“LOCAL ALERT DETAIN IF ENCOUNTERED FALLUJAH 696-0248” 
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“LOCAL ALERT DETAIN FOR INTELLIGENCE RAMADI 696-0248” 

“LOCAL ALERT DO NOT HIRE OR GIVE ACCESS TO US BASES CAMP 
FALLUJAH 696-0248” 

“LOCAL ALERT DO NOT DETAIN OR QUESTION RUSAFA 696-0248” 

B.  Creating a Watchlist in BAT.  In creating a watch list using the BAT, the 
unit/organization must establish standard language to use to flag all persons for inclusion 
in their watch list.  This is to facilitate search-ability in BAT and make RIP/TOA more 
seamless for the follow on forces. 

 
(1) Watchlist Naming Conventions.  All WATCHLISTs names will start and 

end with an asterisk (*).   
a. Example: *MNF-W Watch list* 
b. Watchlist can be named by AO, region, or unit 
c. Example of a RCT/BCT Watchlist: *MNF-W RCT-6 Watch List*  
d. Example of a Battalion Watchlist: *MNF-W 2/6 Watch List* 

 
(2) Establish standard alert text. This is the information that a user will see first 

when encountering an individual on the watch list. For the HIIDE, the first 255 characters 
of the alert text will be displayed.  

 
a. For the BAT [PIER 2-3 Iris Scanning device], the first 16 characters will 

be displayed. 
b. For the HIIDE, the first 255 characters of the alert text will be displayed. 

 
(3) In the “Alert Text” Field, units will include the following information: the 

words “Local Alert”, Action Required, Sought For Detainment (SFD) or location, POC 
information for unit placing the alert. 

 
(4) The remaining fields are for the watch list information on the BAT record. 

This data is only displayed when viewing the individuals BAT record on a laptop, not a 
HIIDE: 
 

a.  Alert Category:  This should include a concise text indicating actions to 
take upon encountering an individual on the watch list and the watch list name. 

 
b. Alert Value:  Watch list specific – Select a value of HIGH, MEDIUM, 

LOW, etc which most appropriately represents the members of the watch list. 
 
c. Alert Region:  This field is typically set to CENTCOM. 
 
d. Alert Contact:  Contact information when a unit encounters an 

individual on the watch list. This should include DSN, SVOIP, and Email if possibly.  
The POC should be the one who has the intelligence to support the capture.  
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e. Alert Detail:  This field is typically the name of the watch list. Ensure 
the watch list name is specific to your unit/organizations name or AOR to facilitate 
searching and ensure your watch list name is unique from other watch lists. 
 

A. Searching for a Watchlist 
 
(1)  Step 1:  In the Personal Data Report, go to the Watch List section. In the 

Alert Category field, select from the drop down what the individuals’ status is. In the 
Alert Value field select the corresponding level of alertness. Alert Region will always 
be CENTCOM. In the Alert Detail field will be the name of the watch list the individual 
is being put on, for example this person is being put on the NGIC and MNFW watch list.  

 
 
(2)  Step 2:  In the BAT search tool, select “Watch – Detail”  

 

 
 

(3)  Step 3:  In the Search Criteria field, the name of the watch list will be put 
here, for example, MNFW. Push the search button to execute (Do not forget to put 
asterisks on both sides of the search criteria). 
 

 
 

(4)  Step 4:  Results of search.  
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6. Assign a BAT Record to a Watchlist 
 

A.   Step 1: Identify the record of the individual to place on the watch list 
 

(1)  Remember, an individual can only be placed on a watch list if his or her 
biometrics has been collected and he or she has a record in BAT.   
 
 

 
Fig. 1 

 
 B.  Step 2: Add the alert text message to the BAT record 

 
(1) Enter edit mode. 
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(2) Click the edit record button (circled in yellow). 
(3) Add alert text. 

 

 
(4) Type in watch list specific alert text message into the alert text – notice 

contact information and watch list name is specified.   
 
(5) Note: Be sure not to delete any text that is already in the alert 

message. Add watch list alert information in front of any text that is already in the 
watch list field. Only the first 255 characters of this text box are displayed on the 
HIIDE. 

 
C. Step 3: Complete the watch list fields in the BAT record  
 

 
 

(1)  Using the information obtained in Part 1, enter it into the watch list fields 
listed here.  See below for an explanation of each field. 

 USMC Watchlist 
Contact USMC WL manager at (123) 456-7890 

DETAIN xxx BIOMETRIC WATCHLIST 

Contact xxx Biometrics at (123) 456-7890 or DSN: 123-456-7890 or NGIC@ usmc 

Watch list 1 of 2 
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a.  Alert Category:  States actions to take upon encountering the 

individual and the name of the watch list. 
b.  Alert Value:  Unit SOP specific. 
c.  Alert Region:  Unit SOP specific. 
d.  Alert Contact:  POC Information for encountering individuals on the 

watch list. 
e.  Alert Detail:  The watch list name. 

 
(2)  Note: If the record is already on another watch list, be careful not to 

alter the existing watch list but instead add an ADDITIONAL Watchlist record: 
 

 
 
 
 
 
 
 
 
 
 
 
D.  Step 4:  Click the green “Plus” symbol to add a new watch list record. In this 

example the individual is already on an NGIC watch list. By clicking the green plus 
symbol you can type in the watch list information without overwriting what NGIC 
already has in the BAT file. 

Contact xxx Biometrics at (123) 456-7890 or DSN: 123-456-7890 NGIC@  

DETAIN xxx BIOMETRIC WATCHLIST 

 
(1)  Note:  Ensure to save your changes by clicking the save button: 

 
 

(2)  At this point the record has been successfully assigned membership into a 
watch list. The next step is to search for everyone on the watch list and load the list into a 
device that can be used tactically in the field. 
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7. Load the Biometric Watchlist from a  BAT client to an Iris Scanner 
 

A.  Pier 2-3 Iris Scanner.  After the device is activated, make sure there is a check 
mark in the Directly to Preview and the Save Iris Images to Server boxes. It is also a 
good idea to take a Test Capture to make sure the iris reader is working properly. Once 
this is done, push OK. Now that the iris device is activated, you are now ready to upload 
data into it. You do this by selecting File>Synchronize Device>PIER>Upload (as 
shown below). 

 
(1)  Step 1: Upload 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2)  Step 2:  Now this window appears: 
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(3)  Step 3:  From here select if you want to merge records with what is already 
on the device, or if you want to overwrite the records, then select next.  I suggest 
Overwriting the records because everyday personnel are taken off of alert and new 
personnel are put on alert. If you merge records then you risk keeping an individual on 
alert in your iris device, which actually might have been taken off of alert on the live 
database. 
 

 
 

(4)  Step 4:  Select if you want to upload the right and left irises, just the right, or 
just the left, then select next. If you select the right and left irises you will only be able to 
upload 50,000 personnel into the device. If you select just the right irises, then you will 
be able to upload 100,000 personnel into the device. 
 

 
 

(5)  Step 5:  This window tells you how many records are currently on the iris 
device and how many more can be added, select next to proceed. 
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(6)  Step 6:  Push the Green button labeled Search for Dossier (circled in red). 
 

 
 

(7)  Step 7:  From the drop down list, select how you want to search through the 
records. Once you have selected the preferred criteria, push Filter. The records that 
matched the criteria will appear on the left side of the window (pictured below).  
 

 
(8)  Step 8:  From here you can select one dossier at a time to move over by 

pushing the > button, or you can move all of the records over by pushing the >> button. 
 

UNCLASSIFIED – FOR OFFICIAL USE ONLY 
 



UNCLASSIFIED – FOR OFFICIAL USE ONLY 
 

 
 

(9)  Step 9:  Now that all of the records you wish to upload onto the iris device 
are on the right side of the window, push the Upload button (circled in red). Once the 
upload is complete the following window will appear - - Push OK. 
 

 
 

(10)  Step 10:  Now that the upload is complete, you will be taken back to the 
main BAT window. You have now completed the upload process and are ready to use the 
iris device disconnected for identification purposes ONLY.  Turn off the iris device, 
disconnect the cross over and power cables from bottom of device, then turn the iris 
device back on. Push the C/F3 button, then the B/F2 button. Use the device like normal 
to take a ‘picture’ of a subject’s iris. 
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8. Load HIIDE with Watchlists from BAT 

• Verify BAT Network Settings 

• Start>Network Connections>Local 
Area Connection 

• Right click on Local Area Connection 
and select Properties 

 
 
 

.  Loading everyone assigned to one or more watch lists is a simple matter of 
searching for them in BAT and then instructing the BAT client to push the data into the 
HIIDE device. HIIDE is used for this manual because it is slightly more complicated than 
loading a Pier 2-3 device.  Note: You CAN add more than one watch list to a HIIDE.   
See Appendix P Uploading data in the HIIDE.  
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Appendix B- Database Replication and Communications Networking Procedures.  
 
 

 
 
 
Recommended Positioning of Clients and Servers in the Network: 

 
(a) To minimize the number if systems attempting to pull data base updates 

and new entries over Wide Area Network (WAN) links, designate a single “master” 
Client/Server at each site that replicates over the WAN link to update the database. 
 
All other BAT clients & servers at that local site should update their data bases from the 
“master” Client/Server over the Local Area Network (LAN). 
 

(b) Even with the 128KB limitation, there is a significant potential impact to 
overall SIPRNET connectivity for a site, of replicating the BAT data base over WAN 
links.  In addition to degrading the connectivity for other C2 traffic riding SIPRNET, 
performing BAT data base replication over WAN links with insufficient capacity may 
adversely impact the replication of the BAT data base as well.  To mitigate the impacts 
on overall SIPRNET connectivity as well as to facilitate the successful replication of the 
BAT data base, the following guidelines are provided: 

    (1)  Outlying sites connected by high capacity satellite systems, cable or 
terrestrial links (1024Kb or greater dedicated SIPRNET) can attempt full data base 
replication (to include intelligence attachments). However units may be better served by 
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replicating the skeleton database and only downloading intelligence attachments as 
needed per individual record.  

   (2)  256Kb SIPRNET is the optimum for on-line replication of the 
skeleton records database, which maintains the basic text file, photographs, and biometric 
data. (No intelligence functions).  Intel documents can still be selectively downloaded for 
individual records.  

   (3)  Less than 128KB dedicated SIPRNET, units may one way push new 
enrollments to a server in off hours, but will use physical synchronization ‘sneaker net’ 
and update via a direct connection to maintain an updated database. 
 

(c)  The Client/Server designated as “master” should point itself to replicate 
with an upstream server that is the closest and most capable network connection (not 
necessarily the closest geographic proximity): 

(1)  Directly connected to Camp Fallujah (i.e. TQ, Baharia, etc.) 
(2)  Directly connected to Al Asad (i.e. Hit, Al Qaim, KV, Hadditha, 

Rawah, Waleed, Trebil, etc.) 
(3)  Directly connected to Camp Ramadi (i.e.Blue Diamond, 

Correigedor, etc.) 
(4)  One hop away from Camp Fallujah (i.e. directly connected to TQ, 

Baharia, Camp Ramadi, etc.) 
(5)  One hop away from Al Asad (i.e. directly connected to Hit, Al 

Qaim, KV, Hadditha, Rawah, etc.) 
(6)  If both are available, a terrestrial connection is preferred over a 

satellite connection – even if the satellite connection has moderately more bandwidth 
(e.g. a 256K terrestrial link is roughly equivalent to a 384K satellite link for the purposes 
of actual throughput) 
 

(d)  Any BAT system that is more than two hops away from Camp Fallujah 
or Al Asad may encounter enough difficulty in trying to replicate its data base that it will 
require irregular “sneaker netting”  in addition to replication to keep up.  This does not 
preclude the local commander or S-6 from trying to establish the connection and 
replicate.  The success in doing so will lessen the frequency in sneaker netting. However 
an assessment to the overall benefit and SIPRNET connectivity from the site should be 
done first and the impact of the replication on SIPRNET connectivity should be closely 
monitored. 
 

(5)   Site Transmission Capacity Planning Factors and Considerations 
 

(a)  An optimum of 512Kb needs to be allocated for SIPR in order to 
maintain a constantly updated, local client-to-server (enrollments, badging, and 
screening) transactions at the lower tactical (OP/ECP) level.  Sites that fall within this 
capacity include those listed below as well as those meeting the minimum requirements.   
 

(b)  A minimum of 1024Kb aggregate needs to be allocated for SIPR to 
support limited (potentially in excess of 24 hour delays), server-to-server database 
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replication (Intelligence functions, Bn level and higher).  Sites that fall within this 
capacity include:  
     - Hit 
     - Hadditha City 
     - Al Qaim 
     - Habbaniyah 
     - Fallujah Development Center 
     - Rawah 
 

(c)  A minimum of 2048Kb aggregate needs to be allocated for SIPR to 
support full, server-to-server database replication (Intelligence functions, Bn level and 
higher).  Sites that fall within this capacity include:  
     - Taqqadum 
     - Camp Fallujah 
     - Al Asad 
     - Korean Village  
     - Baharia 
     - Camp Ramadi 
 

(6)  TTPs for Connectivity ISO On-line and Physical synchronization Data 
Base Replication 
 

(a)  DO NOT attempt to download the complete BAT data base over the 
network.  Units adding a new BAT client to the network must first down-load the current 
data base from an FSE, another client/server via a direct connection (e.g. cabled in – not 
over the LAN or a WAN link) or from an external/portable flash memory device. 
 

(b)  If a BAT system has been disconnected from the network for an extended 
period of time (more than 7 days) it’s data base should be updated via a direct connection 
to another client server or over a LAN connection but NOT over a WAN connection. 
 

(c)  In order to ensure effective, efficient and successful database replication, 
the following guidelines are provided: 

1. 128Kb nominal should be dedicated bandwidth (b/w) for server-client 
replication. 

2. 256Kb nominal should be dedicated b/w for server-server replication 
3. 512Kb nominal should be dedicated b/w for full replication (including 

Intel attachments (occurs only between CF, BD, and AA BAT servers)) 
4. In the event that there are multiple SIPRNET circuits to the same 

desired destination, ensure that the appropriate weights are set on the router to utilize 
both routes (routes are load balanced).  Route weights should not be changed or 
manipulated until detailed planning and coordination has been done up to at least the 
MSC/MSE level and must be closely monitored for second and third order effects.    

5. Initial bandwidth limit set on BAT database replication will be 
128/256K 
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6. Identify consistent failure to successfully replicate the BAT database 
while your network is at steady state to the next senior S/G-6 and BAT POC and in your 
operational chain of command. 
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APPENDIX C.  HOW TO ACTIVATE THE BAT PERIPHERALS 
 
Once you are connected to BAT and see the below screen, you are ready to connect the 
peripherals in order to begin identifying/enrolling an individual.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select Devices from the drop down menu and pick which peripheral(s) you would like to 
activate.  
 

 
 
If you plan on doing a complete enrollment (highly recommended), going from top to 
bottom to connect the peripherals is ideal.  
 
 
Select Digital Camera and the below screen appears: 
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Select the drop down arrow to select the appropriate camera: 
 

 
 
Once you have selected the type of camera you are connected to, push OK and this set-up 
window appears: 
 

 
 
First you will need to push the Activate Camera button (the lens of the camera should 
pop out), and then the set up window will look like this: 
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Now you should see that the camera is Activated in the green text under the Camera 
Status section. In the Live View section, ensure there is a check in the Show Live 
Preview During Capture box, and that the flash settings are set to Always On. It is 
recommended that you take a test photo to ensure that the camera is working properly, by 
selecting the Take Test Photo button. Once this is complete, select OK.  
 
 
Go back up to the Devices drop down menu and select the next item, Fingerprint 
Reader, and this screen appears: 
 

 
 
Select from the drop down arrow the appropriate fingerprint device (shown below) to 
connect to. 
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Once you have selected the type of fingerprint reader you are connected to, push OK. 
Notice that no set-up window appears. The fingerprint reader is powered strictly through 
the USB connector, and therefore needs no extra set-up.  
 
Go back up to the Devices drop down menu and select the next item, Iris Reader, and 
this screen appears: 
 

 
 
Select from the drop down arrow the appropriate iris device (shown below) to connect to. 
 

 
 
Once you have selected the type of iris device you are connected to, push OK and this 
set-up window appears: 
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Push the Connect button in order to activate the iris device. Once the device is activated 
the screen will look like this: 
 

 
 
Ensure that there is a check mark in the Directly To Preview and Save Iris Images To 
Server boxes. Once that is done, it is recommended that you take a test capture. Push the 
Test Capture button. Once you have successfully taken a good capture, push OK.  
 
You are now ready to identify/enroll an individual.  
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APPENDIX G.  IDENTIFICATION AND ENROLLMENT PROCESS 
 

Normally using quick identification through quick mode to see if an individual is already 
in the system is the ideal process, but in Iraq it is time consuming and there is a better 
process in which to ID and enroll an individual without having to open/close/and cancel 
out of different windows to do so. Instead of selecting the lightning bolt button from the 
menu bar, select the pencil (Enroll) icon.  
 

 
 
After selecting the enroll icon, this screen appears: 
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From here, if the individual has a badge that was made with a BAT system, scan the 
barcode with a barcode scanner, or enter the 8-digit letter/number combination (which 
corresponds with the barcode) in the Badge ID # field. Push the Next> button to identify. 
If the individual does not come up, or they do not have a badge, proceed to identify the 
individual with their right iris. Push the Acquire button under Right Iris. You will be 
prompted to scan the individuals’ right iris. Once a good capture has been taken, you will 
automatically be brought back to this window and the box in the Right Iris section will 
have a picture of the iris you just captured. Push the Next> button in order to do an iris 
identification. You will see the below screen while this is occurring: 
 

 
Once the system is finished with the identifying process, you will either see a window 
with suspected matches (directly below) or another screen (NOTE: there will be no 
information in the Step 3. Enter Contact Information window fields like there is below): 
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If the above screen comes up, it means the individual is not already in the system and 
 

of this 
o 

 you are going to put this individual on alert for any reason, this is where you do that. 
 

 

they need to be enrolled. On the left hand side of this window you do not need to fill in
the information at this time because you will fill it in once you open up the EFT 
(Electronic Fingerprint Transaction). Do fill in every field on the right hand side 
window. Once you have completed the fields on the right, push the Next> button to get t
Step 4. Enter Additional Contact Information window (shown below).  
 
 

 
 
If
Ensure you check the Alert box, then put why you are putting them on alert in the Alert
Information text field. Once this is complete push Next> two (2) times to get to the Step
6. Capture Fingerprints window (shown below).  
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Push the Acquire button in the Fingerprints section in order to complete the EFT. If you 
do not remember how to complete the EFT, see Annex C – How to correctly fill out the 
EFT during enrollment.  
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APPENDIX E.  HOW TO PROPERLY FILL OUT THE EFT DURING 
ENROLLMENT 
 

The EFT (or Electronic Fingerprint Transaction) is one of the few standardized 
forms in the BAT system. It is also an official FBI form and has to conform to certain 
standards in order to be useful to all of the agencies that use it. The following instructions 
and screen shots should help you in filling out the EFT correctly and complete.  

Step 1: Double click on the Biometrics Client Icon  to open BAT and 
connect to either the local database or a remote server. Once BAT is open, go to the 
‘device’ drop down menu to connect and set up the peripherals (see Annex A if you do 
not remember how to connect the peripherals). 
 
  

  
 

Once the peripherals are set up and you have verified that they are working, you 
are ready to fill out an EFT on a local or third country national.  
 

Step 2: There are three ways you can start the enrollment process depending on 
your preference: 
 

   
 
  1.          2.     3. 
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Once you select an option to begin the enrollment process, this screen shows up: 
 

 
 

Step 3: Do NOT fill in anything on this window. Instead select the Acquire 
button in the Fingerprints window. Once you select Acquire, this window will appear:      
 

 
EFT – Electronic Fingerprint Transaction. 

It is easier to work your way from top to bottom on the left hand side versus using 
the tabs at the top; it also ensures that you input all of the necessary data without leaving 
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anything out. The Transaction Information window is basically just letting you know 
what type of ‘fingerprint’ transaction you are doing, criminal/civil enrollment, or 
fingerprint image searches; the originating and destination agencies; and the date of 
enrollment. You will NEVER change anything on this particular screen.  
 

Step 4:  Select the Subject Data button, and this window appears: 
 

 
 

It is required to fill in the yellow fields, except for Full Name. The Full Name 
field is automatically completed upon filling in the First, Middle, Last, and 
Tribe/Extended fields.  
 
 
 
 
 
 

Step 5: Input the persons’ first, middle, and last name. Select the ellipses button  

 and the following window pops up:  
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Once you select which tribe the i
 

Step 6: The next field is Person 
select Enemy Prisoner Of War or Ene
the ONLY three options you are allowed
terrorist/insurgent, there is no question th
it. If the individual is a ‘suspected’ terro
(NOTE: This can be changed to EPW if
and Witness’s, for example, would be cl
 

Step 7: Reason Printed is a free
gets entered here, just tell me why you a
would be: Witness, Local Hire Screening
Suspected IED emplacer, Attacked Coal
Printed is automatically filled in for you
 

Step 8: Select from the Birthpla
individual was born.  
 

Step 9: In the Birthdate field typ
A lot of the people you deal with will no
it. If they only know the year they were 
0101. If they have no idea when they we
the Age Range field input the approxim
are between 25 and 30, you would type 2
 

Step 10: Gender is self explanat
Under no circumstances are they a male
options available.  
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NOTE: The only countries that have 
tribes pre-populated are Afghanistan 
and Iraq. 
ndividual belongs to, click OK.  

Type. Click the down arrow and from the list 
my Combatant, Other, or Unknown. Those are 
 to select. An EPW is a confirmed 
at they are guilty and there is evidence to prove 

rist/insurgent, they are classified as Unknown. 
 confirmed at a later date). Iraqi Police, Civilians, 
assified as Other.  

 text field. There is no set standard as to what 
re taking their fingerprints. Some examples 
, Iraqi Police Screening, Terrorist/Insurgent, 

ition Forces, Detainment, etc. Notice that Date 
.  

ce drop down menu the country where the 

e in their date of birth in YYYYMMDD format. 
t know their date of birth, but might know part of 
born, enter the four-digit year and follow it by 
re born, type in 00000000 (eight zeros) and in 
ate age range. For example, if you believe they 
530 in the field (no spaces, no dashes). 

ory. The person is Male, Female, or Unknown. 
 or female impersonator or any of the other 
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Step 11: Race – All Iraqis are classified as Caucasian/Latino UNLESS they 
have Asian characteristics, in which case they are classified as Asian. This standard came 
down from a higher echelon and was effective September 26, 2006.  
 

Step 12: Height can be entered one of two ways. For example let’s say the 
individual is 5’7”. This would be typed as 507 or N67. If the person is 5’11”, it would be 
entered as 511 or N71. If you do not have a way to measure the individuals height input 
000 (three zeros) and in the Height Range field give their approximate height. This 
would be entered as six digits, with no spaces or dashes. For example you believe the 
person to be between 5’7” and 5’10”; you would enter this as 507510.  
 

Step 13: In the Hair Color field select what color their hair is. Only select bald if 
the person is naturally bald. If they are bald by choice (meaning they shave their head), 
what color are their roots, if you can’t tell, look at their eyebrows. If you still don’t know, 
then select unknown. If the person dyes their hair, select the color that corresponds with 
their natural hair color, and if you can’t tell, then select unknown.  
 

Step 14: In the Weight field insert the persons’ weight. If they weigh less then 
100 pounds, input a zero in front of the number. If the person weighs 95 pounds, you 
would type 095. The maximum number you can type in the field is 499. If the person 
weighs more then 499 pounds type 000 (three zeros) and in the Weight Range field type 
in their weight, which would be entered as six digits, with no spaces or dashes, for 
example 500520. Three zeros is also put in the weight field if you don’t know their 
weight, then the same rules apply for weight range.  
 

Step 15: In the Eye Color field select from the drop down what color their eyes 
are. If they are wearing colored contacts, have them removed so you can see their natural 
eye color.  
 

Step 16: If the Date of Arrest field is yellow, then it needs to be filled in with the 
arrest date, then you would select the Arrest Info tab at the top (pictured below) and fill 
in the yellow box with the required information. If the field is white, then it does not need 
to be filled in.  
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Step 17: Depending on what fingerprint device you are using depends on what 
fingerprints you capture from the subject. If you are connected to the Crossmatch 
Verifier 300, then you would only take flat prints of each finger individually. If you are 
connected to the CrossMatch ID 442R, then you would take slaps of each hand 
(excluding the thumbs), each thumb separately, then each finger and thumb would 
individually get rolled. Beside each finger is a box that is checked. If the person you are 
enrolling is missing a finger(s) or hand(s), then you would deselect the box corresponding 
to the missing finger. This box appears if you deselect a finger: 
 

 
 

Select the reason you are not taking the print of that particular finger, then the 
corresponding box is grayed out and you are not required to take that particular print.  
 

Step 18: Under Face Photographs the most important photo you take is the Full 
Face Photo. This particular photo is the only one the BAT system will search against for 
facial recognition. Unless your SOP/TTPs require you to take the 45 degree or side 
profile photos, there really is no need to take them. Once you take the full face photo, 
continue to scroll down on the left-hand side of the screen in order to capture the right 
and left irises.  
 

Step 19: Select the Right Iris button and the iris device will automatically be 
ready for you to capture the subject’s right iris. After a good capture is completed, you 
will automatically be prompted to capture the left iris.  
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Step 20: Now that you have completed all of the required information in each 
field working your way from top to bottom, you are now ready to push the OK button. 
One of two things will happen when you push OK; one of these windows will pop up:  
 

  
 

If you get the EFT Validation Errors window, double click on the line error, and 
you will be taken to where the error is in order to fix it. If you get The EFT Records 
Passed Validation With No Errors, select OK. Once you select OK, you will 
automatically be returned to the first screen with the information you just collected filled 
in the corresponding fields. 
 
 
 
 
 

 
 
 
Step 21: Select Next and you will be taken to the Identifying window (pictured 

below). 
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Once the system has gone through the identification process, you will either get a 
window that says No Matches, or a screen listing the possible matches.  
 

 
 
 

 
 

Meanings of the colored dots:  
 

GREEN: The information matches. 
RED: The information does NOT match. 
YELLOW: The information is a POSSIBLE match. 
BLACK: The record in the results section does not have information 
entered in the specific field. 
WHITE: The person you enrolled did not have any data entered in this 
specific field.  

 
Step 22: If you get the No Matches window, press OK, then select the Next 

button and proceed to the next step. If you get a window populated with possible 
matches, look at the possibilities and decide whether or not it is the same person. If you 
are absolutely positive that it’s the same person, double-click on the record to open and 
update it. If you are NOT sure it is the same person, select the Next button to continue 
enrolling the person in front of you. The below screen is the next step. 
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Step 23: Enter more Contact Information in this screen. NOTE: If there is a drop-
down arrow, select from the list first before free-typing the information. For example, if 
you were to select the drop-down for Birth City/Village, nothing would show up, the 
same for Birth State/Province. The key here is to go from larger to smaller, thus first 
selecting Birth Country, then Birth State/Province, and so on. After you fill in the known 
information, select Next to continue to the next screen. 
 

 
 

Step 24: This screen is very important, especially if you intend to put the 
individual on ALERT for some reason. Depending on why the individual is being 
enrolled, putting them on alert if they committed a crime, or are suspected of committing 
a crime is important. First, ensure you put a check in the Alert box, then in the Alert 
Information input the reason they are being put on alert. 
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NOTE: Be sure to input the most important information first because when 

ou upload data into the iris device to use it disconnected for identification 
purpos
y

es, only the first 16 characters will show up. Put the POC information at the 
end. For example, you could input: “IED Maker – 22 January 2007, SSgt Lake, 
Co, DSN: 822.7745.” After you complete this section (If Needed), select Next to proceed
to the next window. 
 
 

2/3 G 
 

 
 

te

 
 
 
 
 
 
 
 
 
 
 
 

 
S p 25: Here you have the option to take additional photos. Select Next to 

proceed. 

 
 

 
 

tep 26

 
 
 
 
 
 

 
 
 
 
 
 
S : Here you have the option to re-acquire fingerprints, or acquire them for 

the first time if you for some reason skipped this during the EFT process (which you 
should never do). Select Next to proceed. 
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Step 27: Here you could re-acquire irises, or acquire them for the first tim

 reason skipped this during the EFT process (which you should never do). Select 
 to proceed. 

e if you 
for some
Next
 

 
Step 28: This window lets you know if you have inform

Black dots mean you DO NOT have information in the field, and 
DO have information in the field. The only two dots that should be Black are the 
Photo and the Full Body Photo. Every other dot should be gr

ation in the fields or not. 
Green dots mean you 

Profile 
een, if they are not, select 

the <Ba

 
 

Select OK, then the individuals’ dossier will load and appear for you to either edit 
or add even more detailed information about this person into numerous fields and/or 

ck button to go to the corresponding field to complete that specific information. 
When complete select Finish and this window will appear: 
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reports. You have now completed the EFT to standard and properly enrolled a person into 
the BAT system. CONGRATULATIONS! 
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APPENDIX F.  RAPID ENROLLMENT 

 
Rapid Enrollment enables the user to collect biometrics from an individual, ID 

them in a queue, take biometrics from another individual while the first person is being 
identified, and then to come back to the record(s) at a later time to complete the 
enrollment. Rapid Enrollment is NOT to be confused with Quick Mode, they are 
completely different. Following are the steps on how to use the Rapid Enrollment 
function.  
 

Open BAT and connect to either the local database or a remote server. Plug in, 
turn on, and connect the BAT peripherals. If you have used BAT before, this process is 
exactly the same. Once you have connected the peripherals and verified that they are 
working properly, open Rapid Enrollment.  
 

 
 

Once that is selected, this window appears: 
 

 
 

Here you select what biometrics to use for the identification process in the 
Matching section. You want a check in Irises, and for Fingerprints pick whichever you 
want, ideally All is probably the best option. In the Enrollment section, ensure there is a 
check in the Open a Dossier on Enrollment box and then select if you want the 
dossier/record to open in Edit or Read Mode. Depending on your mission, you might not 
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want to have the dossier open on enrollment, but for most cases you probably will want 
that checked. Select OK to bring up the enrollment and queue windows.  
 

 
 
 

The Step 1. Enter Identifying Information (PRE-ENROLLMENT) window is 
exactly the same steps and process that you have been taught in the past. Remember, we 
still ALWAYS do an Identification first. If the individual you need to identify has a 
badge that was made with a BAT system, scan the barcode or type in the 8-digit 
letter/number combination corresponding to the barcode and push Submit ID. If they 
don’t have a badge, push Acquire under the Right Iris and scan the individuals’ eye, 
followed by pushing Submit ID.  
 

The main difference after pushing Submit ID is the person being identified goes 
into the ID Queue (directly below the Step 1 window, circled in red) to be identified. 
While this person is being identified, you’re still at the Step 1 window to enter identifying 
information about the next person in line. Once you push Submit ID for the second 
person there will be 2 individuals in the ID Queue.  
 

 
 

Above is the ID Queue. Notice under the Status section on the right one of the 
individuals’ status is Identifying and the other is Completed with a 0 on the right side. 
The 0 means there were no matches to that specific identification. Identifying means the 
system is searching for matches.  
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When you are ready to complete the enrollment process, Cancel out of the 

enrollment window (the window you acquired the right iris and/or typed in the badge 
number in) and double click on the persons’ record you want to complete from the ID 
Queue.  
 

If you were to close out of the ID Queue accidentally, you can bring it back up by 
going to the View drop-down menu and selecting ID Queue.  
 
 

 
 

The below window is what you will see, along with whatever information you put 
in during Step 1 on the left side. On the right side are the identification results. If there 
were any possible matches you would see that and be able to select the record that 
matches and update as needed. On the bottom you have the option to do a Tracking 
Report, Enrollment, or to completely close the record.  
 

  
 

If you select to do a Tracking Report, this is what you’ll see: 
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Here you will fill in the description of the incident and the corresponding 
information in the other fields, then select OK.  
 

If you choose to do an enrollment, this window comes up: 
 

 
 

You always have to complete the EFT first vice filling in any information in this 
window or the pre-enrollment window. From here, push the Next button (3 times) until 
you get to the below window: 
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Push the Acquire button to open up the EFT. If you don’t remember how to 
correctly complete the EFT, refer to Annex C - How to Correctly Fill out the EFT 
during Enrollment. Once the EFT is complete, push OK.  
 

Now push the Back button until you return to the below screen:  
 

 
 

Complete as much information as you can on this screen, than push Next to get to 
the following window: 
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If the person you are enrolling needs to be put on alert, do that here. When 
complete push Next (4 times) to get to the last screen. You already obtained all of the 
individuals’ biometrics during the EFT so there is no need to re-capture them in the 
following windows. Push the Finish button and the following window appears:  
 

 
 

You ALWAYS want to complete/finish the EFT, so select yes. You’ll either get 
the message that the EFT passed validation with no errors, or you’ll get the window 
telling you what the errors you need to fix are. Once the EFT has been submitted, the 
enrollment will be complete, and the dossier will open if that is the option you selected at 
the beginning. You have now completed an enrollment using the Rapid Enrollment 
function.  
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APPENDIX G.  HOW TO UPLOAD DATA TO THE IRIS DEVICE 
 

 

Double click on the Biometrics Client Icon  on your desktop to begin. After 
clicking on the icon, the below Connections window appears. Push on the connect 
button (circled in red), then the Connect To Server window appears.  
 

 
 
In the Connect To Server window, push the drop down arrow key to select either the 
local database, or a remote server to connect to. If you connect to the Local Database, 
there is no User Name or Password. If you select a remote server to connect to, the User 
Name and Password will be the same one you used to login to the computer. Once you’ve 
selected which server you’re going to connect to, push OK. Now back at the 
Connections window push Finish. After BAT loads all of the necessary programs, you 
will see the main window (pictured below). 
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Now you need to activate the iris device by selecting Devices from the menu bar and 
selecting Iris Reader (pictured below). 
 

 
 
Once you select the Iris Reader, the following window appears.  
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Push the drop down arrow key to select which iris device you are connecting to. Push OK 
to proceed to the following set-up window: 
 

 
 
First, ensure that the IP address matches what the iris device itself displays (push F9 on 
the device to get that information). Once verified, push the Connect button (circled in 
red) in order to activate the iris device. Once activated the window will look like this: 
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After the device is activated, make sure there is a check mark in the Directly To Preview 
and the Save Iris Images To Server boxes. It is also a good idea to take a Test Capture 
to make sure the iris reader is working properly. Once this is done, push OK. Now that 
the iris device is activated, you are now ready to upload data into it. You do this by 
selecting File>Synchronize Device>PIER>Upload (as shown below). 
 

 
 
 
 
 
Now this window appears: 
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From here select if you want to merge records with what is already on the device, or if 
you want to overwrite the records, then select next. I suggest Overwriting the records 
because everyday personnel are taken off of alert and new personnel are put on alert. If 
you merge records then you risk keeping an individual on alert in your iris device, which 
actually might have been taken off of alert on the live database. 
 

 
 
Select if you want to upload the right and left irises, just the right, or just the left, then 
select next. If you select the right and left irises you will only be able to upload 50,000 
personnel into the device. If you select just the right irises, then you will be able to 
upload 100,000 personnel into the device.  
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This window tells you how many records are currently on the iris device and how many 
more can be added, select next to proceed. 
 

 
 
Push the Green button labeled Search for Dossier (circled in red). 
 

 
 
From the drop down list, select how you want to search through the records. Once you 
have selected the preferred criteria, push Filter. The records that matched the criteria will 
appear on the left side of the window (pictured below).  
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From here you can select one dossier at a time to move over by pushing the > button, or 
you can move all of the records over by pushing the >> button.  
 

 
 
Now that all of the records you wish to upload onto the iris device are on the right side of 
the window, push the Upload button (circled in red). Once the upload is complete the 
following window will appear - - Push OK. 
 

 
 
 
 
Now that the upload is complete, you will be taken back to the main BAT window. You 
have now completed the upload process and are ready to use the iris device disconnected 
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for identification purposes ONLY. Turn off the iris device, disconnect the cross over and 
power cables from bottom of device, then turn the iris device back on. Push the C/F3 
button, then the B/F2 button. Use the device like normal to take a ‘picture’ of a subjec
iris. 
 

t’s 
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APPENDIX H.  HOW TO LINK ENTITIES 
 

Marines in Al Anbar Province are beginning to issue out vehicle decals in certain 
cities to the residents that live there. In order to keep track of the residents’ vehicles and 
the decal number associated with said vehicle, it is best to enroll the vehicle, and then 
link it to the owner/driver. Even though there is a vehicle section in the personal data 
report, there is nowhere to insert a vehicle decal number. You could put the decal number 
in the description field, but you would NOT be able to search for it that way, and the 
whole point is being able to search on anything that is entered in the BAT system. When 
an individual is issued a vehicle decal, in the vehicle section of the personal data report, 
record all of the vehicle information as shown below (Type, Make, Model, Year, Color, 
and Plate number).  
 

 
 

Save the record after updating, and leave it open while opening a new 
transportation.  
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Now that you have a new transportation, fill in the Transportation Type (the 
same thing you put in the type field in the personal data report). The Description field 
would also contain the same information you put in the Make, Model, Year, Color 
fields in the personal data report. The Registration # field is where you would insert the 
vehicle decal number you just issued the person for their vehicle. Once this information is 
filled in, save the data, and leave the record open so the vehicle can be linked with the 
owner.  
 

Since you have both records open (person and transportation), it is easier to link 
them by being able to view both at the same time. This is done by going to the Window 
drop down and selecting Tile Horizontal. 
 

 
 

Afterwards you will be able to see both records simultaneously, as shown below: 
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Here you click and drag either the person or transportation into the other record 
and a Relationship Tool window appears (shown on next page). You click on either the 
individuals’ name (circled in red) or on Transportation (circled in red) and drag it into 
the white portion of the other record and let it go. The mouse should look like this when 
it has successfully been grabbed. 
 

 

 
 

In the Description field just type “owner of vehicle” and push OK. Another 
window pops up telling you The Relationship is established. Push OK.  
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Push the save button to save all changes. Notice now in the Related Entities 
section on the left hand side of both records that there is now a number in the parenthesis 
letting you know that there is some sort of relationship.  
 

Now you have successfully linked two records together. If the need ever arises, 
you could link anyone or anything to any of the other 18 entities in the BAT program. It 
is done the same way as described above.  
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APPENDIX I.  HOW TO SET UP THE BAT BADGE PRINTER 
 

If you have been issued a badge printer with your BAT system, following is the steps 
to correctly set up the printer.  
 

 
Badge Printer 
 

The badge printer is connected to the BAT system via USB, and plugged into a 
power source (pictures below).  
 
 
USB Cable 
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Power Connector into power port on back of Printer 
 

 
What the Printer should look like when plugged in correctly 
 
 

 
Printer USB cable gets plugged into the BAT laptop USB port 
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USB Cable completely connected to BAT laptop 
 

Once the badge printer is plugged into a power source, and the BAT system, you 

are now ready to set up the printers’ settings. Go to the Start    button and 
select Printers and Faxes.  
 

 
 

Once selected, the below window appears: 
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Notice that there are now two (2) DTC400 Card Printer options available to 
you? (Copy 1) appears after one of them, and is in Ready status. The other printer is 
Offline. The DTC400 Card Printer that is OFFLINE, right click on it and delete it 
(shown below). 
 

 
 

Once that is complete, right click on the ready DTC400 and Set as Default 
Printer.  
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Right click on the printer again, and select Properties.  
 

This window appears after doing so: 
 

Select the Advanced tab to bring up the below window: 
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Push the button labeled Printing Defaults to bring up the below window (image 
1), and then select the tab labeled Calibrate (image 2).  
 

 
Image 1     Image 2 

 
 

Push the button labeled Sensors to bring up the below window: 
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Once here, push the Send button in order t
system has beeped twice, push the Close button; o
insert the ribbon (pictures below). 
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ribbon inserted in the badge 
printer. 
o calibrate the badge printer. Once the 
pen the ribbon cover on the printer, and 
This is the box the ribbon 
comes in. Take out the 
ribbon, and remove the 
plastic covering.  
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        **Remove both of these pieces of tape 
 
          Now insert the ribbon into the printer (as shown below), then close the printers’ lid.  
 

 
 

Now you need to insert the badge cards into the right side of the printer (as shown 
below), then close the lid once complete.  
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On the left side of the printer is a lid/cover that needs to be in the down position – 
that is where the completed badges come out. (plastic keeps the maintenance to 
minimum) for the dust and dirt 
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Now you should be back to this window: 

 

 
 

Select the Device Options tab: 
 

 
 

From here select the drop down arrow that corresponds to Ribbon Type. 
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Here you need to ensure that the ribbon type selected matches the ribbon type of 
the box you just removed the ribbon from. Once that is verified, push OK and you will be 
returned to the previous window under the Advanced tab settings. Select the tab labeled 
General and push the button labeled Print Test Page.  
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Once a test badge has successfully been printed then you are ready to begin 
printing badges.  
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APPENDIX J.  HOW TO RECORD RESIDENT BADGES IN BAT 
 

Now that certain cities in Iraq are becoming more controlled, the residents are 
being issued resident badges by Marines located at ECP/TCPs or other checkpoints. This 
process ensures that non-residents are not going into a city they do not belong in. After 
seeing firsthand how these various points are working at issuing the badges, here is what 
works, what doesn’t, and the process of how to record the barcode number in a BAT 
record so that it can be searched against by just the number.  
 

After you issue a resident a badge, keep their record open, which it should already 
be since you have to have it open in order to print a badge. If you closed it, open the 
individuals’ record and click on Personal Data located under the Reports section on the 
left side of the record.  
 

 
 
 

In order to input anything into the record you need to be in edit mode, which you 

do by clicking on the paper/pencil icon   After you are in edit mode select the little 
down arrow button to bring up the list of all the sections in the record (shown below).  
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Little 
Arrow 

 
From here select ID Numbers and you will see this screen: 

 

 
 

In the ID Number Type: field type in the corresponding city the individual is a 
resident of. Please see Annex C - Badge Naming SOP for Resident BAT ID cards for 
the name of the badge for your specific area. For example, the Hadithah Triad is using 
TRIAD, and this includes Hadithah, Haqlaniyah, Barwanah, Albu Hyatt, and the dam. In 
the ID Number: field you will type in the 8 digit letter/number combination on the badge 
you just printed for that specific individual. If for some reason something else is being 
typed in the ID Number Type field, just delete what is there and retype what the correct 
ID Number Type is for your particular AO.  

 

 
 

 
Now you ask what the point of recording this information is and how do I search 

for it? This is how you search for personnel by their ID Number Type, or ID Number. 
Make sure BAT is open and you are at the main BAT screen (shown below). 
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          You can search for someone a few different ways. One way is to select File>Open 
Find>Person.  
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          Or you can push one of these two buttons: 
 
 
          This search window appears:  
 

 
  
          From here you would select how you are going to search for the individual, 
specifically by either the badge type or badge number.  
 

 
 
          If you have a specific badge number you want to search for, select ID# - Number 
and put in the corresponding 8 digit letter/number combination from the badge. If you 
want to search for a certain type of badge, for example, everyone in the system who was 
issued a badge in the Hadithah Triad area, then you would select ID# - Type. Once you 
make the selection how you are going to search for the badge(s), then another field comes 
up. 
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          In the Enter search criteria field you would type TRIAD, or the corresponding 
name-type from the badge-naming SOP mentioned previously. Now push the Search 
button and everything that matches that criteria you specified will show up. 
 
 
 
APPENDIX K.  HOW TO EXPORT COPY FROM CLIENT TO 
SERVER AND SERVER TO CLIENT 
 

This is for the personnel who do not have SIPR connectivity for their BAT system 
and need to update their systems manually from the server and vice versa. First you will 
need to open up the BAT program. Once complete you will see the below screen: 
 

 
 

UNCLASSIFIED – FOR OFFICIAL USE ONLY 
 



UNCLASSIFIED – FOR OFFICIAL USE ONLY 
 

Before you go any further ensure you have the network cable plugged into the 

back of your system and the system you want to connect to.  
 

After that is complete, you will go to File>Export>Dossier: 
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This screen appears once the following step is complete: 
 

 
 

Make sure the Export Copy radio button is selected, push Next to get to this 
screen: 
 

 
 

In the Remote Server field, input the IP address of the computer/server you want 
to export data to, and then push Connect. The below window should appear letting you 
know that you are connected to the other system and it is ok to proceed. If you get an 
error message, then you need to check the IP address you entered, and make sure the 
network cable is plugged into both systems in the correct port(s).  
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ush OK, then select Next on the bottom of the screen to get to this screen: 

 

 
or the Entity Type you want Person. If you are exporting data from your 

system  

) 

CREEN LOOKS LIKE THIS WHEN SELECTING COMPLETE ENTITY: 

P

 

F
 (the one that is used disconnected) to a server (or a system that connects to a

server) then select Export Complete Entity. If you are exporting the new data from a 
server (or system that connects to a server) to your system (which you use disconnected
then you select Export Skeleton Entity (With Photos), then select Next to get to the 
following screen. 
 
S
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SCREEN LOOKS LIKE THIS WHEN SELECTING SKELETON ENTITY WITH 

These screens tell you what data is going to be included in the data being 
exporte e. 

This screen is again letting you know the system/server is compatible to continue 
with th

PHOTOS: 

 
 

d. You should never have to change anything so just push Next to continu

 
 

e export, select Next to continue. 
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At this window push the button labeled Newer Than Remote. Remember, the 
system you are exporting data to has records on it, as does your system. You are only 
updating the server/system with the NEW data they don’t already have, thus selecting 
that option. Since the systems have to compare every record on their respective systems, 
this process will take awhile before the left side window is populated with records.  
 

 
 

Once the comparison is complete, push the button with the double arrows on it >> 
to move the records to the right side of the window (as shown below). 
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Once the records are on the right side of the window, push Export.  
 

 
 

If this window appears, at the bottom under Default Deconfliction Behavior 
select Always set the remote value = my local value. This window appears: 
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Select Yes 

 
Once you select Yes, you need to select one of the four options; you will select 

OPTION 4: Set the Remote Value = My Local Value.  
 

 
 

When the export is complete, select Yes to exit the export wizard. You have now 
successfully updated the server/client with the new records.  
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APPENDIX L.  HOW TO SET-UP, ACTIVATE, AND UPLOAD 
DATA TO THE HIIDE 
 

First you need to verify the BAT Network Settings by going to Start>Network 
Connections>Local Area Connection. Right click on the Local Area Connection and 
select Properties. Click on Internet Protocol (TCP/IP) and select Properties. Verify the IP 
address is set to 10.0.0.?? (The last 2 numbers of the BAT system number except 1, 10, or 
255). 

 
Proceed to take the HIIDE out of the pelican case and connect it to the BAT 

system. The HIIDE is equipped with a power cable, crossover cable, soft case with strap, 
and a battery charger with spare battery. Below are some pictures of the HIIDE along 
with where and what the items on the HIIDE are.  

 

 
Front of HIIDE 

 
1. Iris Camera 
2. Face Camera 
3. Flash 
4. IR Illuminators 
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Top of HIIDE 

 
5. Fingerprint Scanner 
6. Shoulder Triggers 
 
 

 
Back of HIIDE 

 
7. Power Light 
8. Touch Screen 
9. Power Button 
10. Power Port 
11. USB Port 
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Side of HIIDE 

 
12. Crossover Port 
 
Now that you have an idea of where and what everything on the HIIDE is, plug in 

the power and crossover cable. The crossover cable goes into the back of the BAT system 
in the same port you use for the iris device.  

 
Power on the HIIDE and touch the screen to begin.  
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You will be prompted to type in the User Name and Password. Touch anywhere 

inside the User Name field and the keyboard (on the right) will pop up. Both the User 
Name and Password is hiide. After you have typed in the User Name and Password push 
Login (on the bottom far right of the first picture). Once logged in you will see the 
following screen: 

 

 
 

 

Push the icon in front 
of the word ‘HIIDE’ 
to bring up a menu.  
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Ensure the Device IP is set to 10.0.0.10 and the Subnet Mask is set to 

255.255.255.0 as shown above. Push the Save button if you had to change either number, 
then push the Close button to return to the previous screen. Now that you have verified 
the BAT system settings and the HIIDE settings it is now time to upload data to the 
device.  

 
Proceed to login to BAT using the assigned credentials. Once you are connected 

to BAT and see the below screen, you are ready to connect the HIIDE. 
 

 
 

 You can connect the HIIDE device by selecting Iris Reader from the Device 
drop-down menu, or you can go directly to the upload window to connect the HIIDE. 
Since we are uploading data to the HIIDE we will connect the device at that time. Go to 
File>Synchronize Device>HIIDE>Upload (shown below).  
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 This window appears: 
 

  
 
 Push OK to continue.  
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 Ensure the IP address in the IP Address field says 10.0.0.10 before pushing the 
Connect button (the HIIDE is set up just like the Pier 2.3 iris device in this respect). 
Once verified, push the Connect button. Depending what is on the HIIDE screen; you 
may connect automatically, or see the following error message: 
 

  
 
 If you get this error message, on the HIIDE device logout so that you are at the 
below screen then push Connect again.  
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Once connected to the HIIDE, the window will look like this telling you in green 
text that your device is now active.  
 

  
 
 Push OK to continue to the following window. 
 
 

 
 
 Always select the radio button for Overwrite Records, then push Next to 
continue.  
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 At this screen there should be a check in EVERY box EXCEPT for the Upload 
Supplemental Biographics box. Push Next to continue. 
 
 

 
 
 This window is just telling you what is already on the HIIDE and what can be 
added, push Next.  
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 Push the green button labeled Search for Dossier to bring up the Filter Builder 
window (shown below).  
 
 

 
 
 From the ‘Select field to search on:’ drop-down select the Watch – Detail option. 
Once selected another field appears (shown below).  
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In the ‘Enter search criteria’ field will be the specific watch list you are going to 

 to 

  
  
 You can also push the Add Criteria button to search for multiple watch lis  to 

  
 

After you are done adding all of the watch lists you want to upload to the HIIDE, 
ush the Filter button to execute the search. Once the search is complete all results that 
atche

 
upload to the HIIDE. Most likely you will be uploading the NGIC (National Ground 
Intelligence Center) watch list as well as the MNFW watch list. In order for the search
work, whatever watch list you are uploading needs to be enclosed in asterisks (*NGIC*), 
or else you will not get any results. For example the window will look like this: 
 

ts
upload.  
 

 
p
m d the search criteria will appear in the left-hand side of the window as shown 
below: 
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 Push the double arrow button (>>) to move all of the records to the right side of 
the window as shown below: 
 
 

 
 
 Once all of the records are moved to the right, push the Upload button to begin 
the upload process. Once the upload is complete the below window will appear: 
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UNCLASSIFIED – FOR OFFICIAL USE ONLY 

 

  
 
 Push OK, than exit out of the Upload Wizard. You have now set-up, activated, 
and uploaded specific watch lists to your HIIDE device. You are now ready to go out on 
patrol and use your HIIDE to identify any person you come in contact with to see if 
they’re on a watch list.  
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